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About Microsoft Document Imaging Format (MDI)
Microsoft Office Document Imaging uses Microsoft Document Imaging
Format (MDI), a file format based on the Tagged Image File Format
(TIFF) that is designed to store images by page layout. In Office
Document Imaging, you can open and save files in the MDI format as
well as the Tagged Image File Format (TIFF) format. Both formats are
capable of storing text recognized by optical character recognition (OCR)
along with images.

File format comparison
While you can open and edit TIFF files created with Office Document
Imaging by using many other graphics applications, MDI files can only be
opened or edited in Office Document Imaging. If you are going to share
files with people who are using Office Document Imaging 2002, or
another document imaging program, save your files in TIFF format for
compatibility.
MDI files have the following advantages over TIFF files:
Reduced file size Images that are saved in the MDI file format take up
less disk space than the same images saved in the TIFF format.
Improved image fidelity Images saved in the MDI file format are
generally higher fidelity (or quality) than the same images saved in the
TIFF (with the Perform lossless compression (LZW). option selected)
format.

File format selection
There are different times within Office Document Imaging when you can
choose the file format (either MDI with an .mdi extension or TIFF with a
.tif extension) for your document:
Scanning a document The scanning preset you choose determines
the format the scanned document is saved in. You can create your own
scanning preset or edit an existing preset to change the file format.
Saving a document You can select the file format in the Save as type
list in the Save As dialog box when you save a file.
Importing a document The File Import preferences button on the
Other tab in the Options dialog box (Tools menu) allows you to select
the default file format for documents that you import from other programs.
Technical details
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About Microsoft Office Document Imaging
With Microsoft Office Document Imaging, you can use a scanned
document as easily as other Microsoft Office documents on your
computer.
You can:
Scan both single and multi-page documents.
Perform optical character recognition (OCR).
Copy and export scanned text and images to Microsoft Word.
Read a scanned document as easily as a paper document.
Search for text within scanned documents.
Reorganize scanned document pages as easily as rearranging papers in
a folder.
Send scanned documents to others in e-mail or as a fax over the internet.
Annotate scanned documents and faxes.
When should you use Microsoft Office Document Imaging?
Use Microsoft Office Document Imaging when you want to:
Access and work with the text or images contained in scanned
documents or faxes.
Extract the text from existing scanned documents or faxes for archiving.
Rearrange the page order of multi-page scanned documents.
Read scanned documents quickly and easily on the screen.
Annotate an electronic fax and return it to the sender.
Scanning and imaging
Microsoft Office Document Imaging actually has two components— a
scanning component and an imaging component— listed separately in
the Windows Start menu as Microsoft Office Document Scanning and
Microsoft Office Document Imaging.

The first component controls the scanning of documents into your
computer by using any installed scanner. This is done by using scanning
presets, which control your scanner by using settings that are optimized
for specific purposes. For example, the Black and white scanning preset
is ideal when scanning pages of text for OCR, while the Color scanning
preset is best for scanning full-color pictures or artwork. Also, OCR is
automatically performed by default on text documents immediately after
scanning, and you can easily scan multiple pages into a single file.
The second component makes it easy to view scanned documents on the
screen, rearrange multi-page documents, select and manipulate
recognized text, annotate scanned documents and electronic faxes, and
send documents to others by e-mail or fax.
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What's new in Microsoft Office Document Imaging
New file format with improved image compression
Support for importing files from other programs
Support for annotating documents
New page pane views
Optical character recognition (OCR) changes
Support for sending documents to a fax service
Support for Automation
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About Tagged Image File Format (TIFF)
TIFF is a commonly used format for various imaging applications,
including those that scan and fax. Microsoft Office Document Imaging
uses the TIFF format, utilizing the format's capability to contain text
recognized by optical character recognition (OCR). When you scan new
documents, they are saved in TIFF format (with a .tif extension), and any
OCR text is stored in the TIFF file along with the image.
You can open and edit TIFF files created with Office Document Imaging
by using many other graphics applications. When you do so, any OCR
text that the file contains is lost. You will have to rerun OCR if you want to
access the text in the TIFF file again in Office Document Imaging.
Technical details
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Command line options
You can use command line options when you start Microsoft Office
Document Imaging from either the Run command (Start menu) or from a
command prompt.
Command
mspview
<path:filename.tif>

Result
Starts Office Document Imaging and opens the
specified file.

mspview
<path:filename.mdi>
mspview -r
<path:filename.tif>

Starts Office Document Imaging and opens the
specified file in Reading view.

mspview -r
<path:filename.mdi>
mspview -o
<path:filename.tif>

Starts Office Document Imaging, performs optical
character recognition (OCR) on the specified file,
and then saves the file with the new OCR text.

mspview -o
<path:filename.mdi> This command has no effect if OCR has already
been performed on the file.
Notes
If the TIFF image is monochrome, it will be
compressed in TIFF CCITT G4 format.
If the TIFF image is grayscale or color, it will be
compressed in TIFF 6.0 JPEG format.
If the MDI image is monochrome, it will be
compressed in MODI BW format.
If the MDI image is grayscale or color, it will be
compressed in MODI Color format.

If the image is over 900 dots per inch (dpi), it will be
saved at 900 dpi.

The file is saved using the additional compression
and OCR settings in the Options dialog box.
mspview -f
<path:filename.tif>

Starts Office Document Imaging, performs OCR on
the specified file, and then saves the file with the
new OCR text.

mspview -f
<path:filename.mdi> Use this command if you want to perform OCR on a
file that has already had OCR performed on it.
Notes
If the TIFF image is monochrome, it will be
compressed in TIFF CCITT G4 format.
If the TIFF image is grayscale or color, it will be
compressed in TIFF 6.0 JPEG format.
If the MDI image is monochrome, it will be
compressed in MODI BW format.
If the MDI image is grayscale or color, it will be
compressed in MODI Color format.
If the image is over 900 dpi, it will be saved at 900
dpi.
The file is saved using the additional compression
and OCR settings in the Options dialog box.
For example, the following command opens Mypic.tif in Reading view.
mspview -r "C:\My Documents\mypic.tif"

Return values

Show or hide a toolbar
On the View menu, point to Toolbars, and then click the toolbar you want
to show or hide.
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About annotating documents
When you are reviewing a Microsoft Office Document Imaging document,
you can use annotations to mark up your document. You can add text as
a note or comment, apply highlighting to important text, draw freeform
text or shapes to circle text in question, or insert a picture in your
document by using the buttons on the Annotations toolbar.

Picture added as an annotation
Highlighting applied to call out important information
Freeform shape drawn to call attention to a detail
Text added as a comment for a reviewer
You can move, resize, and remove annotations. You can select the font
you want to use as well as the background color (if any) for any text you
add to your document. You can also choose the thickness and color of
ink for the pens you use to add highlighting and drawings. Five preset
pens for drawing freeform text or shapes, and three preset pens for
adding highlighting allow you to quickly change pen color and thickness
by clicking the arrow next to the Pen
button or the Highlighter
button.
If you are going to share the document with others who do not have
Office Document Imaging, you can make your annotations a permanent
part of your document so they can view your revisions. When you make
annotations permanent, text that was added as an annotation will be
recognized after you run optical character recognition (OCR).

Other information about annotations
You can display or hide all annotations.
You can print your document with or without annotations.
You cannot add annotations in reading view.
Annotations do not display in the thumbnail pane.
Annotations do not rotate when you rotate a page.
Note When you make annotations a permanent part of the document,
the annotations display in the thumbnail pane and rotate with the page.
Additionally, you can not hide annotations that have been made
permanent or print your document without permanent annotations.

Color annotations in a black and white document
When you add color annotations to a black and white document, you can
choose to retain the color when you save the file (resulting in a larger file
size), or you can choose to convert the annotations to black and white
and maintain the smaller file size.
You can also choose to maintain the color of your annotations when you
copy color annotations to the clipboard.

Show or hide annotations
On the Tools menu, point to Annotations, and then click Show
Annotations or Hide Annotations.
Note To print or insert annotations, annotations must be shown.
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Move an annotation
1. Select the annotation.
How?
2. Do one of the following:
Move by using the mouse
Move by entering measurements
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Delete an annotation
Delete a single annotation
Delete all annotations on a page

Show All

Resize an annotation
1. Select the annotation.
How?
2. Do one of the following:
Resize by using the mouse
Resize by entering measurements

Show All

Apply or remove highlighting
When you apply highlighting, it is added as an annotation to your
document.
Apply highlighting
Remove highlighting
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Draw or change freeform text or shapes
Although you cannot change, or remove scanned text or images on a
page, you can draw freeform text or shapes as an annotation on a page,
and make changes to the annotation.
Draw freeform text or shapes
Change individual freeform text or shape
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Insert a picture
Although you cannot remove or change the size of scanned images on a
page, you can add a picture as an annotation on a page, and then move,
resize, or remove that picture.
1. On the Annotations toolbar, click Insert Picture
2. In the Open dialog box, locate the folder that contains the
picture that you want to insert, and then click the picture file.

.
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Make annotations permanent
Make annotations a permanent part of your document if you want to
share the document with users who do not have Office Document
Imaging and you want them to see the annotations. You can make
annotations permanent in the open document only, or you can make
annotations permanent each time you save a document.
Do one of the following:
Make annotations permanent in the open document
Make annotations permanent every time you save a document
Note When you make annotations permanent, text that was added as an
annotation will be recognized after you run optical character recognition
(OCR).
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Add, change, or delete text
Although you cannot change, or remove scanned text on a page, you can
add text as an annotation on a page, and then change, or remove that
text.
Add text
Change an individual text box
Change text box defaults
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Change predefined pen or highlighter settings
Change predefined pen settings
Change predefined highlighter settings
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About Office Document Imaging Automation
Microsoft Office Document Imaging supports Automation. When an
application supports Automation, the objects the application exposes can
be accessed by Visual Basic. A programmer can use a number of
different programming languages, for example Visual Basic, C++, or
VBScript, to manipulate these objects by invoking methods on the object
or by getting and setting the object's properties. Office Document Imaging
exposes a document object, and a viewer object, so that a program can
be written for example to open a Tagged Image File Format (TIFF) or
Microsoft Document Imaging Format (MDI) document, change the zoom
scale, compression options, and OCR text information.
For details on the properties and methods supported by Microsoft Office
Document Imaging, visit the Microsoft Developer Network Web site.
There you can find the objects, functions, properties, and methods
supported by Microsoft Office Document Imaging, along with additional
programming information and code samples.
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Find MODI VBA Reference on MSDN
The Microsoft Office Document Imaging 2003 (MODI) application
exposes its functionality through programmable objects. However, the
documentation for the MODI object model is not included in the Help files
that were installed when you installed Microsoft Office 2003.
Programmers wanting to use the MODI objects in other applications as
part of a custom application can easily add the MODI object library to
their project. You can also obtain the MODI object documentation on
MDSN.
To add the MODI object library
To obtain the MODI VBA reference documentation
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About importing documents
Importing is a method that allows you to create a digital image of a
document that was created in another program that you can then send in
e-mail as a fax to others, annotate, modify, archive, and share with others
who use Microsoft Office Document Imaging or another imaging software
program. You can import any file created in a program that is installed on
your computer, and that can be printed from that program. When you
import a file, the file is saved in either Tagged Image File Format (TIFF)
or Microsoft Document Imaging Format (MDI) to a location on your
computer's hard disk and opened in Office Document Imaging.

Import preferences
To choose the file format or location on your hard disk for importing
documents, you can use the Preferences button in the Import dialog box
at the time you import, or you can set your preferences at any time by
using the File Import preferences button on the Other tab in the
Options dialog box (Tools menu) .
Caution The Microsoft Office Document Image Writer print driver is
installed with Microsoft Office Document Imaging and is used to import
documents. Do not delete or uninstall the Microsoft Office Document
Image Writer print driver from your computer.

Show All

Export text or pictures
Export text and pictures to a new Microsoft Word document
Copy text to another program
Copy pictures or artwork to another program
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Send a document to someone
Send a document in e-mail
Send a document as a fax over the Internet
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Advanced Scan Settings dialog box
Option
Resolution
(DPI)

Description
Specifies the dots-per-inch resolution for the current
preset. This sets the number of dots per inch scanned
from your original document. Selecting a larger number
will make finer detail visible, but will create larger files and
may take longer to scan.
Note Documents scanned at resolutions greater than
900 dots per inch will be converted to 900 dots per inch if
Auto contrast, Save as monochrome, Auto rotate, or
Auto straighten is selected.

Type

Specifies the amount of information to record for each
pixel to be scanned for the current preset. The options 24
bit color and 8 bit gray record more detailed information
about an image than does Monochrome, but they create
larger files and may take longer to scan.
Auto
Creates high-contrast images for optimum optical
contrast,
character recognition (OCR). After scanning by using the
save as
selected scan type, the resulting file is saved in 1-bit
monochrome monochrome, resulting in a smaller file size. This option
can be helpful when scanning for OCR those documents
with background colors or colored text.
Save files as Specifies the default file format for saving the file with the
current preset.
TIFF
After scanning, the image is saved in Tagged Image File
Format (TIFF). Select Perform lossless compression
(LZW) if you want to share the TIFF images with others.
Select a setting under Optimize JPEG compression in
favor of to specify the compression to perform for the
current preset.
MDI
After scanning, the image is saved in Microsoft Document
Imaging Format (MDI). Select a setting under Optimize
compression in favor of to specify the compression to
perform for the current preset.
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Choose Scanner dialog box
Use this dialog box to select an available scanner.
Option
Scanner
Use
automatic
document
feeder
Show
scanner
driver dialog
before
scanning

Description
Lists the available scanners for your computer. Select the
one you want to use.
Select this check box if your scanner has an automatic
document feeder (ADF), and you want to use it.

Select this check box to display the dialog box for the
scanner software that came with your scanner. This
option is useful if you want to control advanced features
and settings of your scanner.
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Find dialog box
Use this dialog box to search for text in a scanned document.
Option Description
Find
Type the text you want to find.
Previous Click to find the previous occurrence of the text.
Next
Click to find the next occurrence of the text.
Close
Click to close the dialog box.
Options Click to select the search options you want to use. Displays
the Find tab in the Options dialog box.
Note Before you can find text, optical character recognition (OCR) must
first be performed on the document.

Go To Page dialog box
In the Page box, select or type the number of the page you want, and
then click OK.
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Indexing Service dialog box
Indexing is a special service that enables fast file searches on your
computer. Text found in files on your computer is added to the index,
which also stores a reference to the file in which the text was found.
Note You must have administrator permissions to change settings in this
dialog box because indexing is a system service.
Option
Use OCR
to
recognize
the text in
TIFF and
MDI files
when
indexing
Auto
rotate

Description
Select this check box to perform optical character
recognition (OCR) on Tagged Image File Format (TIFF) and
Microsoft Document Imaging Format (MDI) files when the
Windows Indexing Service compiles search indexes. This
allows the Microsoft Windows search function to access text
in TIFF and MDI files that do not already contain OCR
information.

Select this check box to detect the orientation of text on the
page and perform OCR on images that are upside down or
sideways.
OCR
Lists the available languages for OCR. Select the language
Language you want to use.
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Insert File dialog box
Use this dialog box to insert the contents of a Tagged Image File Format
(TIFF) or Microsoft Document Imaging Format (MDI) file into the current
document.
The message "Insert n page(s)" at the top of the dialog box indicates how
many pages the selected file contains.
Option
In front of page
At the beginning of
the document
At the end of the
document

Description
The new pages are inserted before the page
number you select in the box.
The new pages are inserted before the first
page.
The new pages are inserted after the last page.

Launching Scanner Driver dialog box
This dialog box appears when Microsoft Office Document Imaging cannot
set your scanner settings, or when you selected the Show scanner
driver dialog before scanning check box in the Choose Scanner
dialog box. In these cases, Office Document Imaging cannot control
scanner settings from the currently selected scan preset, so you will need
to do so manually.
When you click OK, you'll see the scanner driver dialog box for your
currently selected scanner. Use this dialog box to set desired scan
settings and begin scanning.
Option
Description
Don't Show Me
Select this check box if you want to hide the
This Dialog Again Launching Scanner Driver dialog box in the future.
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Microsoft Office Document Image Writer Properties dialog
box
Use this dialog box to change the file format and location for files that you
import in Microsoft Office Document Imaging. Importing is especially
useful to create a quick copy of a file, maybe for adding annotations and
reviewing. When you import a file, the file is opened and then saved in
the file format, (either Microsoft Document Imaging Format (MDI) or
Tagged Image File Format (TIFF)), and in the location you choose.
Option Description
Output Select the file format you want the new file saved in.
format Select the MDI - Compressed Document Format option when
you want the final document to be saved in color or grayscale.
However, this option results in a larger file size.
Select Compress images in the document if you want a
smaller file size (with degraded image quality.) Clear this option
to retain original image quality but larger file size.
Select the Tiff - Monochrome Fax option for a smaller file size
and when you want the file saved in Black and White.
Tip
Default Specifies the current location for saving imported files. The
folder default location is the My Documents folder.
Browse Click to change the current location for saving files.
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Scan New Document dialog box
You can use the Microsoft Office Document Scanning feature to scan
new documents, as well as to recognize text in existing documents.
Option
Select a
preset for
scanning
Scan
Preset
options

Description
Scanning presets are optimized for different types of
documents. The default preset is Black and white.
Click to scan the document by using the selected preset.
Click to choose one of the following options.
Create new preset Create additional custom scanning
presets for specific tasks by using the Preset Options dialog
box.
Edit selected preset Modify settings in any existing preset
by using the Preset Options dialog box.
Delete selected preset Permanently remove a preset from
the list.

Scanner

Click to select the scanner you want to use. Opens the
Choose Scanner dialog box.
Original If your scanner is equipped with an automatic document
is double feeder (ADF), click this option to scan the front and back of
sided
multiple pages. Place the pages in the feeder so that the
page fronts are scanned first.
The Scan New Document dialog box will reappear, allowing
you to turn the pages over and scan the page backs.
Microsoft Office Document Scanning automatically collates
the pages in the correct order after scanning is complete.
Prompt Click this option to pause after each page is scanned,
for
allowing you to place the next page in your scanner. Or, if you
additional are using an ADF, click this option to pause when the feeder
pages
is empty, allowing you to load more pages.
You can use this option with an ADF when you are scanning

books or other documents that won't fit or are too long to load
into the feeder. The Scan New Document dialog box
reappears after each page is scanned, or after the feeder in
your ADF is empty.
View file Select this check box to open the newly scanned document
after
and display it in the Microsoft Office Document Image Viewer.
scanning

Options dialog box - Annotations tab
Use this dialog box to change annotation settings.
Option
Description
Pen Settings Select this option to open the Pen Settings dialog box.
Click to change the color, thickness, or tip style for the
preset pens or highlighters.
Default font Shows the default font, size, and color used when you
add text to your document.
Format Font Select this option to change the default font, size, and
color used when you add text.
Fill Color
Select this option to change the background color used
for text.
Fill
Select this option to change the transparency percentage
transparency used for text background. Option settings range from
100% (no color, completely transparent) to 0% (solid
color, cannot view the document underneath the text and
background.)
Make
Select this option to make annotations part of the image
annotations when you save the document. If you share documents
permanent with someone who uses another program to view image
when
documents, such as Photoshop or Kodak, select this
document is option if you want your annotations to be visible. You
saved
cannot select or change an annotation in the document
after saving the document with this option selected.
Convert
Select this option to retain color annotations in a Black
black and
and White document when you save the file. This option
white
results in increased files size.
documents
to color
documents
Keep
Select this option to retain color annotations in a Black
annotation and White document when you copy your image and
color when paste it into another program.
copying
image as

bitmap
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Options dialog box - Compression tab
Use this dialog box to change the default file compression settings used
when you save a document.
Option
Description
Perform
Compression option for all new and modified documents
lossless
you save in the Tagged Image File Format (TIFF) format.
compression With lossless compression, all of the information in the file
(LZW)
is completely restored when the file is uncompressed.
Select this check box if you want to share TIFF files with
others. When you select this check box, the Optimize
JPEG compression in favor of: setting is not available.
Optimize
Select a setting to specify the default compression to
JPEG
perform when you save a new document in the TIFF
compression format, or an existing TIFF file that you have made
in favor of: changes to in Microsoft Office Document Imaging. You
cannot select this setting if the Perform lossless
compression (LZW) checkbox is selected.
Optimize
Select a setting to specify the default compression to
compression perform when you save a document in the Microsoft
in favor of: Document Imaging Format (MDI) format.

Options dialog box - Find tab
Use this dialog box to change the settings that are used when you search
for text. These same settings are available when you click Options in the
Find dialog box.
Option
Match full/half
width form

Description
Select this check box to search text without
distinguishing between full-width and half-width
characters.
Match
Select this check box to search text without
minus/dash/cho- distinguishing between minus signs, dashes, and
on
long vowel sounds.
Match
Select this check box to search Japanese text
hiragana/katakana without distinguishing between hiragana and
katakana characters.
Whitespace
Clear this check box when you want to include
characters
spaces in the text you are searching for. For
example, to search for white space and not
whitespace, clear this option.
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Options dialog box - OCR tab
The first three options control optical character recognition (OCR)
settings when you are using the Recognize Text Using OCR command
on the Tools menu.
Option
Auto
rotate

Description
Select this check box to detect the orientation of text on the
page and rotate page images that are upside down or
sideways.
Auto
Select this check box to detect the orientation of text on the
straighten page and correct any slightly misaligned pages.
OCR
Lists the available languages for OCR. Select the language
Language you want to use.
Indexing Click to open the Indexing Service dialog box.
Service
Note Documents scanned at resolutions greater than 900 dots per inch
(dpi) will be converted to 900 dpi if Auto rotate or Auto straighten is
selected.
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Options dialog box - Other tab
These properties pertain to the entire active document.
Option
Reset

Description
Click to specify Office Document Imaging as the default
application used to open Tagged Image File Format (TIFF)
files.
File Import Click to display the Office Document Image Writer
Preferences Properties dialog box.

Preset Options dialog box - General tab
Use this dialog box to specify settings for Microsoft Office Document
Scanning presets.
Option
Description
Preset
Indicates the name of the current preset. When creating a
Name
preset, enter a descriptive name for your preset.
Scan
Specifies the type of scan (color, grayscale, or black and
Type
white) to be performed for the current preset.
Advanced Click to open the Advanced Scan Settings dialog box to
view or modify settings for the scan type.
Create
Click to create and place on the desktop a shortcut icon that
Shortcut launches Microsoft Office Document Scanning and
immediately starts a new scan by using the current preset.
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Preset Options dialog box - Output tab
Use this dialog box to specify settings for saving and naming files created
by Microsoft Office Document Scanning.
Option
Save in folder

Description
Specifies the current location for saving files. The
default location is the My Documents folder.
Change
Click to change the current location for saving files.
Auto name based Select to create file names based on the first few
on first words on words of text extracted using optical character
page
recognition (OCR).
Auto number
Select to create sequentially numbered file names.
Date and time
Select to create file names containing the date and
time of scanning.
Format
Specifies the format to be used for file names
generated by using date and time.
Note If you want to use the Auto name based on first words on page
option, you must select the Use OCR to recognize the text of the
scanned image check box on the Processing tab.

Show All

Preset Options dialog box - Page tab
Use this dialog box to specify settings for the size of pages being
scanned, if applicable, and for automatic document feeders (ADF).
Option
Page Size

Width
Height
Save each
page as a
separate
document

Description
Lists a variety of standard sizes for the page being
scanned. When this option is available, you can select
Custom to specify Width and Height. Available page sizes
depend on the scanner model.
Specifies the width of the page being scanned. Available
only when the Custom page size is selected.
Specifies the height of the page being scanned. Available
only when the Custom page size is selected.
Select to save multi-page scans as separate documents.
This is useful when scanning individual documents using
an ADF.
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Preset Options dialog box - Processing tab
Use this dialog box to specify settings that control optical character
recognition (OCR) and scanning.
Option
Use OCR to
recognize the
text of the
scanned image
Auto rotate

Description
Microsoft Office Document Imaging runs OCR
automatically after scanning is completed. If this
option is turned off, the rest of the options on this tab
are unavailable.
Select this check box to detect the orientation of text
on the page and rotate scanned pages that are
upside down or sideways.
Auto straighten Select this check box to detect the orientation of text
on the page and correct pages that are slightly
misaligned.
OCR Language Lists the available languages for OCR. Select the
language you want to use.
Note Using the Auto rotate and Auto straighten options may slow
down the scanning process. If you are scanning at a higher resolution,
using either of these options also reduces the resolution to 900 dots per
inch.
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Page Properties dialog box
These properties pertain only to a selected page in the current document.
The thumbnail image at the top displays a small representation of a page
in the current document.
Option
Page
scanned
on
Page
scanned
by
Scanner

Description
Time and date that the current page was originally scanned.

Name of the user who scanned the current page.

The model name of the scanner used to scan the current
page.
Scanner
The name and version number of the scanner software
software used to scan the current page.
OCR
Indicates whether or not optical character recognition (OCR)
status
has been performed on the current page.
Image
Lists technical statistics pertaining to the Tagged Image File
parameters Format (TIFF) or Microsoft Document Imaging Format (MDI)
image of the current page, including length and width,
resolution in dots per inch, and type of image compression
used.
Page
Lists statistics pertaining to the results of OCR performed
statistics on the current page only, including numbers of characters,
words, lines, and paragraphs.

Show All

Send Text to Word dialog box
Use this dialog box to send all or part of the current document to
Microsoft Word.
Option
Current
selection
Selected
pages
All pages
Maintain
pictures in
output
Browse

Description
If you selected a portion of the document in the page pane
or in Reading view, select this option to send the selection
to Word.
Select this option to send everything on the selected pages
to Word.
Select this option to send everything in the document to
Word, regardless of the selection.
Select this option to include pictures in the selection,
selected pages, or document in what is sent to Word.
Click to specify the default folder for saving files that
contain what is sent to Word.

Format Object dialog box - Color tab
Option
Color

Description
Select the color you want for the background of the
selected text.
Transparency Select the transparency percentage you want for the
background of the selected text. Option settings range
from 100% (no color, completely transparent) to 0% (solid
color, cannot view the document underneath the text and
background.)

Format Object dialog box - Ink tab
Use this dialog box to change the color or thickness of the selected
freeform text or shape, or highlighting.
Option Description
Based Select this option to apply an existing pen format to the
on pen selected freeform text, shape, or highlighting.
Custom Select this option to apply a custom pen format to the selected
Settings freeform text, shape, or highlighting. Click Color to select the
ink color you want. Click Thickness to select the ink thickness
you want.
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Format Object dialog box - Size and Layout tab
Use this dialog box to change the size or location on the page of the
selected annotation.
Option
Height
Width
Vertical

Description
Enter the height you want for the annotation.
Enter the width you want for the annotation.
Enter the distance from the top of the page you want the
annotation to be located.
Horizontal Enter the distance from the left edge of the page you want
the annotation to be located.

Pen & Highlighter Settings dialog box - Highlighter Settings
tab
Option
Description
Current
One of three preset highlighters you can use to apply
highlighters highlighting to your document. Select the highlighter you
want to change and then select the highlighter settings.
Color
Select the color you want to use with the selected
highlighter when you apply highlighting.
Thickness Select the thickness you want to use with the selected
highlighter when you apply highlighting.
Tip style
Select the style of the highlighter tip you want to use with
the selected highlighter when you apply highlighting.

Pen & Highlighter Settings dialog box - Pen Settings tab
Option
Current
pens

Description
One of five preset pens you can use to draw freeform text or
shapes in your document. Select the pen you want to change
and then select the pen settings.
Color
Select the color of ink you want to use with the selected pen
when you draw.
Thickness Select the line thickness you want to use with the selected
pen when you draw.
Tip style Select the style of pen tip you want to use with the selected
pen when you draw.
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About image compression
Image compression is a technique used for storing a visual image that
reduces the amount of digitized information needed to store the image
electronically. When you save a document in either Microsoft Document
Imaging Format (MDI) or Tagged Image File Format (TIFF), image
compression is used to reduce the size of the file.
The MDI format uses an improved image compression technology that
results in smaller file size, and better image fidelity than the TIFF format.
Change the image compression options when you save a document
Change the image compression options when you scan a document
When you use the Options dialog box (Compression tab) or the
Advanced Scan Settings dialog box to change the compression
options, you can choose to optimize the compression either in favor of file
size or image quality. Saving a document to achieve a smaller file size
will result in more image loss; saving a document for better image quality
results in a larger file size. The optimal setting depends on how you
intend to use the image.

What happens when you change compression options?
When you select a different compression option, the pages in a
document are compressed using the new option under the following
conditions:
you save the document with a different file format or file extension (all of
the pages in the document are saved with the new compression option)
you make annotations a permanent part of the document (any page with
an annotation will be saved with the new compression option)
you make changes to a page (any page that you make changes to is
saved with the new compression option)
So, when you save a file with a different compression option (without
changing the file format), only pages that you have made changes to are
saved with the new compression option. To compress all the pages with a
new compression option, you must make changes to each page. For
example, rotate all the pages in a document 90° right, then 90° left to
make sure that each page is marked as changed, but without actually
making any visible changes to your document.
Technical details
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Change the image compression in a document
Change the image compression in an individual document
Change the image compression settings for all new documents

Image compression options
The Options dialog box, Compression tab allows you to change the
default image compression settings used when you save a document.
The Advanced Scan Settings dialog box allows you to change the
image compression settings used for your selected preset when you scan
a document. The following table provides a few examples to help you
decide which file format and image compression options you need.
To
Do this
share TIFF files with others
Save the file in the TIFF format. Under
who do not use Office
TIFF color compression, select the
Document Imaging and ensure Perform lossless compression (LZW)
that all of the information in the checkbox.
file is completely restored
when the file is uncompressed
save a TIFF image with the
Save the file in the TIFF format. Under
smallest file size when you are TIFF color compression, clear the
not sharing with others and
Perform lossless compression (LZW)
image quality is not an issue checkbox. Under Optimize JPEG
compression in favor of:, drag the
control all the way to the left toward
Smaller file size.
share a file with others who
Save the file in the MDI format. Under
use Office Document Imaging MDI compression, under Optimize
when image quality is not an compression in favor of, drag the
issue
control all the way to the left toward
Smaller file size.
scan a series of color
Edit the Color scanning preset to save
magazine articles with a
the scanned image in MDI format. Work
mixture of text and pictures,
with scanning presets This will give you
and store them on your local a reduced file size over the TIFF format.
hard drive for later viewing
scan and archive last year’s
Edit the Color scanning preset to save
magazine issues
the scanned images in MDI format. Work
with scanning presets The resulting file
will open and display more quickly than
the same images saved in TIFF, and the

scan a large number of black
and white and color images
from a variety of magazines,
newspapers and newsletters,
and e-mail the resulting
documents to other people
scan a number of magazine
articles and white papers and
store the resulting image
documents on a network
server so that a design team
can review and re-use the
document content
scan several documents that
must be shared with the entire
corporation

color images and text will be more clear.
Edit the Color scanning preset to save
the scanned images in MDI format. Work
with scanning presets The resulting file
will have better image quality than the
same images saved in TIFF.
Edit the Color scanning preset to save
the scanned images in MDI format. Work
with scanning presets The resulting file
will have better image quality than the
same images saved in TIFF.

Use one of the default scanning presets
to save the documents in TIFF format so
users of Office Document Imaging and
Microsoft Office Document Imaging
version XP can view.
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Create a document
You can create a Microsoft Office Document Imaging document by
scanning a document, moving pages from a document, or by saving
pages from a document.
Scan a document
Move pages into a new document
Save pages to a new document
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Open a document
Microsoft Office Document Imaging can open Microsoft Document
Imaging Format (MDI) files and most Tagged Image File Format (TIFF)
files.
Do one of the following:
On the File menu, click Open.
On the File menu, click the name of a document that was previously
opened.
Office Document Imaging keeps a list of the last four documents opened.
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Save a document
You can save documents created in Microsoft Office Document Imaging
in Tagged Image File Format (TIFF) or in Microsoft Document Imaging
Format (MDI).
Save a document
Save a document with a different file format or compression option
Save a document with a new file name
Note When you save a file in Office Document Imaging, the optical
character recognition (OCR) text is saved within the TIFF or MDI file. If
you open and save a TIFF file that contains OCR text using another
program, the OCR text will be lost. You must run OCR again using Office
Document Imaging if you want to access the text in the TIFF file.

Print a document
1. On the File menu, click Print.
2. Click OK.
Note In the Print Options list, the Fit to page option reduces images
that are too large, or enlarges small images to fill the page.

Close a document
On the File menu, click Close.
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Accessibility features in Microsoft Office Document
Imaging
Microsoft Office Document Imaging includes features that make the
software accessible to a wider range of users, including those who have
limited dexterity, low vision, or other disabilities.

Keyboard shortcuts
You can carry out commands in Microsoft Office Document Imaging using
the keyboard instead of the mouse.
Get more information about Keyboard shortcuts.

Page size and view options
Change the display size of your page
Change the position of your page on-screen
Use Reading View
Scroll and zoom by using the Microsoft IntelliMouse or other pointing
device

Annotation options
Change predefined pen or highlighter color, thickness, or tip style
Change textbox default font, color, or transparency
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Keyboard shortcuts
You can carry out commands in Microsoft Office Document Imaging using
the keyboard instead of the mouse.
Keys for editing
Keys for undo and redo actions
Keys for file operations
Keys for navigating documents
Keys for navigating and using Help
Keys for navigating in the page pane
Keys for navigating in the thumbnail pane
Keys for navigating in Reading view
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Import a document
You can import any file created in a program that is installed on your
computer, and that can be printed from that program. When you import a
file, the file is saved in Tagged Image File Format (TIFF) or Microsoft
Document Imaging Format (MDI) file format to a location on your
computer's hard disk and opened in Office Document Imaging.
1. On the File menu, click Import.
2. To change the file format or location for the imported document,
click Preferences.
3. In the Look in list, click the drive, folder, or Internet location that
contains the file you want to import.
4. In the folder list, locate and open the folder that contains the file.
5. Click the file, and then click Import.
Caution The Microsoft Office Document Image Writer print driver is
installed with Microsoft Office Document Imaging and is used to import
documents. Do not delete or uninstall the Microsoft Office Document
Image Writer print driver from your computer.
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Insert pages into a document
You can copy a single page, or multiple pages, and paste either into
another Microsoft Office Document Imaging document or within the same
document. Or you can insert all pages from a Tagged Image File Format
(TIFF) or Microsoft Document Imaging Format (MDI) file into any open
document.
Insert a page
Insert multiple pages
Insert all pages from an image document
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Move pages to a new document
You can move pages from an existing Microsoft Office Document Imaging
document into a new document. Use this procedure to divide multi-page
documents into smaller or more meaningful pieces.
Move a single page to a new document
Move multiple pages to a new document
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Copy and paste text and images
Copy and paste text
Copy and paste images
Copy and paste annotations
Copy and paste page contents into another program
Paste images from another program
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Crop a page
If you have a page that is only partially filled with content, you can crop it
within Microsoft Office Document Imaging.
1. On the View toolbar, click Select

.

2. In the page pane, drag the mouse to select just the area
containing the content.
3. On the Edit menu, click Copy Image.
4. In the thumbnail pane, click the thumbnail that precedes the
location where you want to paste the copied image, and then
click Paste Page on the Page menu.
Note This procedure does not alter the original page, but creates a new
page with the cropped image.
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Rearrange pages
You can change the order of pages in a multi-page Microsoft Office
Document Imaging document, or move pages between documents.
Rearrange pages by dragging
Rearrange pages by cutting and pasting
Copy or move pages between two open documents
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Rotate pages
You can change the orientation of scanned pages by rotating them 90
degrees to the left or right, or 180 degrees.
Rotate a page
Rotate multiple pages
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Delete pages
Delete a page
Delete multiple pages
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About OCR international issues
When optical character recognition (OCR) is performed on a scanned
document, text is recognized using sophisticated pattern-recognition
software that compares scanned text characters with a built-in dictionary
of character shapes and sequences. The dictionary supplies all
uppercase and lowercase letters, punctuation, and accent marks used in
the selected language.
By default, Microsoft Office Document Imaging uses the dictionary for the
same language that your other Microsoft Office applications use. You can
easily change the dictionary to scan documents in other languages.
The OCR language dictionary is used in the following scenarios.
Scanning new documents using Office Document Imaging
Running OCR on previously scanned documents
Adding foreign language text to the index for fast file searches
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Recognize Text using OCR dialog box
Use this dialog box to select the pages in the document that you want to
perform optical character recognition (OCR) on.
Option Description
Options Click to open the Options dialog box with the OCR tab
selected. Use this tab to choose whether to detect the
orientation of text on the page, or to choose the language you
want to use to recognize text.
Page
Select Selected page(s) to recognize text only on the pages
range: that are selected in the thumbnail pane.
Select Pages with no OCR information to recognize text only
on pages that have not already had OCR performed on them.
Select All pages to run OCR on all pages in the document.
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About optical character recognition (OCR)
Optical character recognition (OCR) translates images of text, such as
scanned documents, into actual text characters. Also known as text
recognition, OCR makes it possible to edit and reuse the text that is
normally locked inside scanned images. OCR works using a form of
artificial intelligence known as pattern recognition to identify individual
text characters on a page, including punctuation marks, spaces, and
ends of lines.
OCR can be performed in three scenarios:
Automatic OCR runs automatically each time you perform a new scan,
unless you change the scanning presets.
Manual Run OCR manually for documents that were scanned using
another program.
Indexing Indexing is a system service that helps you to quickly find files
on your computer using text searches. When you perform OCR on
Tagged Image File Format (TIFF) or Microsoft Document Imaging Format
(MDI) files, recognized text is available to the index, making it possible to
find relevant TIFF and MDI files when you search. You can index any and
all TIFF and MDI files on your computer.
Setting OCR options
Optimizing OCR accuracy
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About indexing text in TIFF and MDI files
When Microsoft Office Document Imaging performs optical character
recognition (OCR) on a scanned document, the text is stored within a
Tagged Image File Format (TIFF) or Microsoft Document Imaging Format
(MDI) file when you save it.
This text is available not only when you open the document in Office
Document Imaging, but also when you search for files using other
Microsoft Office programs, or when you use Microsoft Windows search
features.
The indexing service
Indexing is a special service that enables fast file searches on your
computer. Text found in files on your computer is added to the index,
which also stores a reference to the file where the text was found.
Without indexing, you can search for words only in TIFF or MDI files that
have had OCR performed on them— either automatically at scan time,
or manually from the Tools menu. With indexing, you can search for any
TIFF or MDI file based on the words it contains.
The indexing service is part of the operating system in both Windows
2000 and Windows XP and the resulting index is used by the search
features in both Windows and Office. For information about controlling
the indexing service in Windows, see Microsoft Windows Help.
If the indexing service is turned off, only the following text is available in
TIFF and MDI files that have not had OCR performed on them: the file
name itself and any file properties that might be available.
Indexing TIFF files without embedded OCR information
OCR is automatically performed on other TIFF and MDI files that exist on
your computer, making the text available to the indexing service for file
searches. In this case, the OCR text is stored only in the index, not within
the TIFF or MDI files. This process takes several seconds per TIFF or
MDI file encountered.
To turn off automatic indexing
1. Click Options on the Tools menu, and then click the OCR tab.

2. Click Indexing Service, and then clear the Use OCR to
recognize the text in TIFF and MDI files when indexing
check box.
Indexing in other languages
If you want to index documents in languages other than your computer's
default language, you can select a dictionary from the OCR Language
list in the Indexing Service dialog box.
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Change the language for optical character recognition
The optical character recognition (OCR) feature of Microsoft Office
Document Imaging can recognize text in any installed language.
1. On the Tools menu, click Options, and then click the OCR tab.
2. In the OCR Language box, select the language you want to
use.
Change the default language setting

About upgrading Optical Character Recognition
Special offer for Microsoft Office Document Imaging
customers
As a Microsoft Office Document Imaging customer, you are entitled to
upgrade to ScanSoft's OmniPage Pro OCR software at a special price.
To learn more about OmniPage Pro OCR and how it can enhance your
scanning capabilities, visit ScanSoft's Information Page
(http://www.scansoft.com/omnipage/officexp.asp.)
Why upgrade?
When scanning documents with Microsoft Office Document Imaging, you
can capture the words from a page, but you lose the layout and format of
your original document. With OmniPage Pro OCR, your scanned
documents retain their original formatting. Simply drag the document
directly to your favorite Microsoft Office application, and you've got a fully
formatted, editable file!
ScanSoft's OmniPage Pro achieves an accuracy rate of over 99%. It
allows you to scan documents directly into Microsoft Office applications
with just the click of a button, which makes the conversion of paper to
editable text so fast and simple that you'll use it instead of retyping. This
means you save time. No retyping, correcting, or reformatting— you
simply scan and go!
About ScanSoft's OmniPage Pro OCR
Features and benefits:
ScanSoft's most powerful recognition engine has a proven accuracy rate
of better than 99%.
True Page® retains color pictures, graphics, illustrations, and artwork,
and accurately places them into the digital document.
ScanSoft's intuitive, user-friendly interface makes scanning simple. You
can:
Scan paper spreadsheets directly into Microsoft Excel.

Convert documents into Microsoft Word format.
Switch paper documents into HTML by using Microsoft FrontPage.
Add paper documents to your Microsoft PowerPoint presentations.
Powerful table-editing tools improve accuracy and give you more
flexibility and control when working with cells. Word tables convert as true
cell tables!
ScanSoft's AutoOCR Toolbar™ guides you through the entire optical
character recognition process.
Voice Read-Back allows you to double-check for errors before exporting
to Word, Excel, or another text-based application by reading OCR results
aloud to you. Voice Read-Back uses the Microsoft Speech Application
Programming Interface (SAPI), the most widely supported speech API in
use today.
The benefit of using ScanSoft's OmniPage Pro? Less editing. Less
proofing. Less work. More speed. They're results you really have to see
to believe!
To order the upgrade, visit ScanSoft's Information Page
(http://www.scansoft.com/omnipage/officexp.asp) or call 888-781-1189.
ScanSoft, Inc.
9 Centennial Drive
Peabody, MA 01960
www.scansoft.com
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About Reading view
Reading view is a special viewing mode that makes it easier to read
scanned documents on the screen. When activated, Reading view
presents the current document and hides most nonessential screen
elements, including the Microsoft Windows taskbar.
To switch to Reading view, click Reading View on the View menu.
The Reading View menu
Navigating in Reading view
Selecting text in Reading view
Closing Reading view
Note To provide an unobstructed reading area, the mouse pointer is
hidden until needed. When you stop moving the mouse, the pointer
disappears after five seconds. To show the pointer again, move the
mouse.
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About the page pane
Use the page pane to view a representation of each page in a Microsoft
Office Document Imaging document at an easily readable size. When
you click an image in the thumbnail pane, that page appears in the page
pane.
You can view or hide the page pane by opening the View menu and then
clicking Page Pane.

Thumbnail pane
Page pane
You can select and copy text in the page pane. Dragging the mouse in
the page pane selects any recognized text within the selection. Only
whole words are selected. If only part of a word lies within the selected
text, the entire word is selected.
Note You can select text in the page pane only if optical character
recognition (OCR) has been performed on a document.

Selecting text in the page pane
After OCR has been performed on a document, you can select text in the
page pane by dragging, just as you can in other Microsoft Office
programs.
When you drag the mouse to select text, only whole words are selected.
If you drag across the middle of a word, the entire word is selected, even
if it falls partially outside the selection rectangle.

The selected text is actually contained in a hidden layer, separate from
the document image. You can select and copy text in this layer just as
you can in a text document.
Copying text or images
Copying and cutting pages
Rotating pages
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About the thumbnail pane
Use the thumbnail pane to select a page in a document for viewing in the
page pane or in Reading view. When you click an image in the thumbnail
pane, that page appears in the page pane.
You can show or hide the thumbnail pane by clicking Thumbnail Pane
on the View menu.

Thumbnail pane
Page pane
Sizing the thumbnail pane
Sizing thumbnails
Rearranging thumbnails
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Select a page thumbnail
In the thumbnail pane, you can select page images to view, copy, or
delete.
Select a thumbnail
Select a series of thumbnails
Select thumbnails not in a series

Go to a specific page
You can quickly jump to any page in a multi-page scanned document.
1. On the Edit menu, click Go To Page.
2. Select or type the number of the page you want.
3. Click OK.
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View an open document
You can view any or all open documents in Microsoft Office Document
Imaging.
Switch to an open document
View all open documents
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View page thumbnails
Use the thumbnail pane to navigate through multi-page documents.
1. On the View menu, click Thumbnail Pane if it is not already
selected.
2. On the View menu, click Thumbnails, and then click the size
you want. The default size is Medium.
Tip
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Change the display size or on-screen position of a page
You can zoom to change the size of images displayed in the page pane,
or pan to change the on-screen position of pages in documents that are
displayed at a large zoom percentage.
Change the display size of a page
Change the on-screen position of a page

Show All

About scanning
Microsoft Office Document Imaging combines and manages the separate
tasks of scanning documents and performing optical character
recognition (OCR) on scanned documents. In most cases, Office
Document Imaging streamlines these tasks by controlling the scanner
software and initiating the OCR process without further intervention.
Scan presets
When you scan a new document, Office Document Imaging provides
several presets, offering easily selectable settings for common scanning
tasks. Each preset is optimized for different scanning needs. You can
customize presets, or you can create your own presets for specific
purposes. Built-in presets include the following:
Black and white Scans in monochrome at 300 dots per inch. This preset
is designed for optimum OCR results when scanning black text on white
paper, or when scanning line art. Scanning is faster than with other
presets, and the resulting image files are small.
Black and white from color page Scans in grayscale at 300 dots per
inch, but saves the resulting file in monochrome format. This preset is
designed to provide maximum text resolution for OCR when scanning
difficult originals containing colored backgrounds or colored text.
Grayscale Scans in grayscale at 200 dots per inch. This preset is useful
when scanning pages containing continuous-tone, black and white
images (such as photographs) and text, or colored text. This preset
creates somewhat larger image files.
Color Scans in color at 200 dots per inch. This preset is designed for
scanning full-color documents. Scanning is slower, small text may not be
legible enough for OCR, and the resulting image files are large.
In addition to resolution and scan type, each preset controls the following
settings:
Page size
Default folder for saving files
Language used for OCR

Save multi-page documents together or as separate pages
Automatically perform OCR after scanning
Automatically create file names
Automatically adjust pages scanned upside down or out of alignment
Scanner drivers
If possible, Office Document Imaging manages the scanning process for
you. If you want to adjust settings yourself, you can choose to display
your scanner driver dialog box each time you scan. To do so, click Scan
New Document on the File menu, click the Scanner button, and then
select the Show scanner driver dialog before scanning check box. If
this option is not available, Office Document Imaging displays your
scanner driver dialog box each time you scan.
Automatic document feeders
Automatic document feeders (ADFs) operate in different ways,
depending on the type of scanner. Flatbed scanners sometimes have
add-on feeder attachments, while multi-function scanners usually have
integral feeders. The first time you scan, Office Document Imaging
detects the ADF for you.
Notes
If you want to check your settings or turn off ADF support, click Scan
New Document on the File menu, click the Scanner button, and then
select or clear the Use automatic document feeder check box. If this
option is not available, Office Document Imaging displays your scanner
driver dialog box each time you scan.
When scanning multi-page documents using an ADF, Office Document
Imaging usually combines all the scanned pages into a single file on disk.
If you prefer to save each page separately, click Scan New Document
on the File menu. In the Scan New Document dialog box, click Preset
options, and then either click Create new preset, type a name for the
new preset, and then click OK or click Edit selected preset. On the
Page tab of the Preset Options dialog box, select the Save each page
as a separate document check box.

TWAIN-emulation drivers will not appear in the Scanner list in the
Choose Scanner dialog box.
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Work with scanning presets
Presets are collections of settings used to initiate specific types of scans.
When you create or edit a preset, you control the settings for that preset
only. All other presets remain unaffected. This way, you can create
presets for specific purposes. Microsoft Office Document Imaging comes
with several built-in presets for common scanning tasks.
Edit an existing preset
Create a new preset
Delete a preset
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Scan a document
You can scan double-sided documents, multi-page documents, or
multiple single-page documents in one continuous operation. You can
save the individual pages in a single Tagged Image File Format (TIFF) or
Microsoft Document Imaging Format (MDI) file, or you can save each
page as a separate file.
When you scan and perform optical character recognition (OCR) on color
documents or photographs, you can optimize scanner settings either for
accuracy (when scanning for text recognition) or for maximum resolution
(when scanning photographs).
Scan a single-page document
Scan multiple pages into a single file
Scan multiple pages into separate files
Scan a color document
Scan a color photograph
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Scan a document of poor quality
You can use scanning presets to maximize the accuracy of optical
character recognition (OCR) on documents of poor quality, whether they
are in color or black and white.
Scan a document for optimum OCR
Increase the scanning resolution
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Scan a foreign-language document
By default, Microsoft Office Document Imaging performs optical character
recognition (OCR) automatically when you scan a document, using your
computer's normal language settings. Office Document Imaging can
perform OCR on documents in any installed language dictionary.
Scan and recognize text in a foreign-language document
Recognize text in a previously scanned foreign-language document
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Align scanned images
Use this procedure to correct the orientation of pages that were scanned
upside down, sideways, or out of alignment.
1. On the Tools menu, click Options, and then click the OCR tab.
2. Select the Auto rotate and Auto straighten check boxes, and
then click OK.
3. On the Tools menu, click Recognize Text Using OCR.
If you've already performed optical character recognition (OCR)
on the current document, a confirmation message appears.
Tip
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About finding text
Use the Microsoft Office Document Imaging Find command on the Edit
menu to locate specific words, word fragments, phrases, or punctuation
marks in a scanned document. When text is found, it is highlighted in the
page pane, which scrolls multi-page documents to the appropriate page.
Each time you click Next or Previous, additional occurrences of the text
are highlighted in the page pane.
Before you can find text in a scanned document, optical character
recognition (OCR) must be run on that document. To find text in an
annotation, the annotation must be made a permanent part of the
document, and OCR must be run again on the document.
If the Use OCR to recognize the text of the scanned image check box
on the Processing tab of the Preset Options dialog box is selected for a
preset, text recognition is automatically performed on any documents that
you scan using this preset.
After text is recognized, it is stored in the Tagged Image File Format
(TIFF) or Microsoft Document Imaging Format (MDI) file when you save
the document. If you then edit a TIFF file that you saved in Microsoft
Office Document Imaging using another program, the text is lost and you
must perform OCR on that file again.
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Find text
You can search a Microsoft Office Document Imaging document for
specific text. Before you can find text, optical character recognition (OCR)
must be run on the scanned document. To find text in an annotation, the
annotation must be made a permanent part of the document, and OCR
must be run again on the document.
Find text
Reuse a previous search
Notes
The Find command is case-insensitive, treating uppercase and
lowercase characters the same.
By default, leading spaces and trailing spaces are ignored. To change
this, click the Options button in the Find dialog box. Under Ignore, clear
the Whitespace characters check box.
Common OCR errors are ignored. For example, the letter combination
"rn" is often incorrectly recognized as "m," so the Find command will
locate both. However, this can occasionally cause false matches.
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Troubleshoot annotations
I can't select multiple annotations
I can't copy annotations
Other people can't view annotations in my document
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Troubleshoot scanning
The scanned text of my document is hard to read.
My scanned photos or artwork are of poor quality.
When I run optical character recognition (OCR), there are too many
text-recognition errors.
Scanning a document takes too long.
My scanned files are too large.
I can't select text in a scanned document.
The automatic document feeder doesn't work.
I can't scan multiple pages into the same file.

